
In nature, light flows like a luminous tide,
revealing and concealing form. Light 
radiates, reflects, refracts, reacts, and softly
diffuses into air. Light is warm or cool, high
or low, near or far, bright or dim, harsh or
soft. These qualities make a scene happy,
sad, harsh, soft, romantic, dull, mundane, 
or mysterious (Figure 11.1).

In the digital world, illumination is a calcu-
lated affair. Rendering algorithms, normal
alignments, G-buffers, and Z-buffers deter-
mine the display of light and shadow. Where
calculation fails, the eye of the artist must
compensate. 

The best lighting effects are achieved by
artists who make themselves students of
nature. Artists who study scene painting,
drawing, photography, and cinematography
develop sensitivity, awareness, and a 
practiced eye. 

This chapter outlines the light sources avail-
able in 3ds max and how to control them.
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Figure 11.1 Light conveys mystery and magic.
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Illuminating Scenes
In addition to making scenes more 
beautiful, working with light has practical
applications. For instance, suppose you 
create a model of an office building for a
prospective client. The client will want to
see what it will look like under different
lighting conditions. How will the building
cast shadows? How will shadows be cast
upon it? At what angle will light enter the
windows at different times of the day 
and year? 

The color and angle of a light place a scene
in time and space. For morning or evening
scenes, make the sun a warm color such as
yellow, orange, or red. Then place the light
source at a low angle (Figure 11.2). Cooler
white lights placed at a high angle suggest
the sun shining at midday. To make a mid-
day scene more interesting, add clouds to
the sky and project shadows from them
(Figure 11.3). Fill lights above the ground
should be blue or gray to match the sky. Fill
lights below the ground should be green or
brown to match the earth. 

For night scenes, use a cool blue-white tint
to suggest the light of the moon and stars
(Figure 11.4). If there is fog, streetlights 
create warm, hazy cones of illumination. If
there is a large or brightly colored object in
the scene, match a nearby light to that color
to create the effect of light radiating off of
its surface.

Indoor lights also have color. Use warm, 
yellow colors for incandescent and halogen
lights. Use a cold yellow-green color for 
fluorescent lighting. Be sure to create some
fill lights to match the overall colors of the
walls and carpets.
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Figure 11.2 Morning in the mountains: Angled light,
long shadows.

Figure 11.3 Midday in the hills: Cloud shadows add
interest.

Figure 11.4 Moonlight in the desert: Stars in the sky
and water create a feeling of space.
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Creating Lights 
As in nature, illumination in 3ds max is the
product of a complex interaction of lights
and objects. To participate, lights and
objects must be placed so that there is a
direct line of sight between them, and
objects must be renderable. 

3ds max 5 offers four basic types of lights
(Figure 11.5):

◆ Omni light—Radiates light in all
directions from a single source point. 

◆ Skylight—Simulates diffuse outdoor
lighting from the dome of the sky. 

◆ Spotlight (target and free)—
Illuminates an area within a cone, similar
to a stage light. Target spotlights point 
at a target that you aim. Free spotlights
have no target, so they can be maneu-
vered more easily.

◆ Directional light (target and
free)—Like spotlights, directional lights
use a cone of illumination, except that
the cone sides are parallel. This is
because directional lights have parallel
rays, while spotlights spread light from a
single source point. 

You create basic lights in the Lights branch
of the Create panel (Figure 11.6). 
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Figure 11.5 The basic light types. Free
spotlights and free directional lights
look the same as their targeted
counterparts, minus the target box.

Omni light

Target spotlight

Target directional light

Skylight

Figure 11.6 The Lights branch of
the Create panel.
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In addition to the basic light types, there are
two types of lighting systems that you create
in the Systems branch of the Create panel:

◆ Sunlight system—A hybrid light
source that combines a free directional
light with a Compass object to simulate
the position of the sun as it moves across
the sky over time. 

◆ Daylight system—A hybrid light source
that combines the direct light of the sun
with the scattered light of the sky to 
produce realistic outdoor lighting that
changes over time. Daylight systems use
an advanced type of lighting called pho-
tometric lights by default (see sidebar).

By default, shadow casting is turned off for
basic lights and turned on for lighting sys-
tems. Ambient light, the diffuse background
light of a scene that fills in shadow areas, is
turned off by default. 

When you start building a scene in 3ds max,
the default lighting has no direction. No
matter which viewport you look in, the light
appears brightest on the sides of the objects
that face you. This lighting configuration
was designed to make modeling easier, as
the object facing you in the middle of the
viewport is always fully lit.

There is a second default lighting configura-
tion that places two omni lights along a
diagonal through the world origin, from top-
left-front to below-right-back. This lighting
is more realistic and interesting.
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Photometric Lights

Photometric lights simulate realistic
lighting based on physical measurements
of light intensity. 3ds max offers eight
types of photometric lights: target point
lights, free point lights, target linear
lights, free linear lights, target area lights,
free area lights, IES skylights, and IES
sunlights. For more information on pho-
tometric lights and their settings, see the
3ds max 5 User Reference.
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Lighting requires a bit of finesse. To make
the process easier, you will start by creating
a practice scene, and then add lights to it
until the scene is fully illuminated. 

To create a practice scene:

1. Rotate the Perspective view so that the
grid is parallel to the edges of the view-
port (Figure 11.7).

2. In the Perspective viewport, create some
light-colored objects and place them
near the origin. Then place a white plane
underneath (Figure 11.8).

The light colors of the objects will make
it easier to see the effects of light.

3. With the Perspective viewport still
active, open the Viewport Configuration
dialog box by right-clicking a viewport
label and choosing Configure, or right-
clicking any viewport control button.

4. In the Rendering Method tab panel,
check Default Lighting and select 2
Lights (Figure 11.9). Then click OK.

5. Change the Perspective viewport to an
ActiveShade viewport by choosing
ActiveShade Viewport in the Rendering
menu, or by right clicking the viewport
label and choosing ActiveShade 
under Views. 

The ActiveShade viewport renders the
scene (Figure 11.10).

6. In the Front viewport, zoom out
and pan so you will have plenty of room
to place lights around the scene.

7. Choose File > Save, and name your scene
Practice.max.

8. Choose File > Save As, and name your
scene Practice00.max. This will serve as a
back up copy in case you accidentally
save over your scene.
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Figure 11.7 When you build a scene on a grid that is
grid parallel to the viewport, it makes it easier to
position lights around it.

Figure 11.8 The practice scene consists of light-
colored objects.

Figure 11.10 The ActiveShade viewport renders the
new default lighting.

Figure 11.9 This
setting creates two
default lights that
you can later add
to the scene from
the Views menu.
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As you do geometry objects, you create light
objects by clicking and dragging. As soon as
you create a light, the default lighting is
turned off and the new light illuminates 
the scene.

A common way of lighting scenes is to use a
bright key light for primary illumination of
a scene, and one or more fill lights to make
the dark edges of forms more discernable.

In the next three exercises, you’ll create a
spotlight and an omni light for your key
light and a fill light, and then add a direct
light to serve as an accent light. 

To create a target spotlight:

1. Open Practice.max. 

2. In the Create panel, open the
Lights sub-panel.

3. In the Object Type rollout, click Target
Spotlight.

4. In the Front viewport, click in the 
upper-left corner to create the spotlight.
Then drag to the center of the scene to
create the target and aim the light
(Figure 11.11). 

The spotlight illuminates the objects
within its cone. The default lights are
turned off (Figure 11.12).

5. In the General Parameters rollout, enable
Shadows (Figure 11.13).

The objects cast shadows. If the
ActiveShade viewport does not show the
shadows, right-click in the viewport and
choose Initialize from the Tools quad
menu.

The viewport is redrawn. Shadows
appear in the ActiveShade viewport and
in rendered views (Figure 11.14). 

6. Save the scene as Practice01.max. 

320

Chapter 11
Cr

ea
ti

n
g

 L
ig

h
ts

Figure 11.11 A target spotlight has a source, a cone
of illumination, and a target.

Figure 11.12 The cone of illumination delimits the
pool of light.

Figure 11.14 The objects cast shadows based on
the position of the source.

Figure 11.13 After enabling
shadows for the spotlight.
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There are many parameters you can adjust
on a light, but the settings that you usually
adjust right away are the intensity, color,
position, and aim. Additional light settings
are explained in the sections on shadow
casting and controlling illumination. 

To adjust a target spotlight:

1. Open Practice01.max.

2. Select the spotlight. 

3. Open the Modify panel.

4. In the Intensity/Color/Attenuation 
rollout, increase the Multiplier to 1.25, 
or just enough to brighten the scene
without washing it out (Figure 11.15).

5. In the Intensity/Color/Attenuation roll-
out, click the white color swatch. 

6. In the Color Selector: Light Color dialog
box, select a color using the Hue and
Whiteness sliders, or type in the RGB or
HSV amounts (Figure 11.16).

7. In the Top viewport, select and move
the light so that it is about 30° in front
of the scene (Figure 11.17).

8. Right-click on the light and choose
Select Target from the Tools 1 quad
menu.

9. Move the target to the origin. You can do
this easily by right-clicking the X, Y, and
Z spinners of the Transform Type-in
boxes on the status bar, while in Absolute
mode.

10. Render your scene to see the result
(Figure 11.18).

11. Adjust the light further until you are 
satisfied. Then save your scene. 

321

Lights
Creatin

g
 Lig

h
ts

Figure 11.16 Selecting a color for the light.

Figure 11.17 After positioning the light to the front of
the scene.

Figure 11.18 After repositioning the light and its target.

Figure 11.15 The Multiplier increased
to 1.25.
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Omni lights have only a single component.
Similar to a bare light bulb, they are the 
simplest lights to create and adjust.

To create an omni light:

1. Open Practice01.max. 

2. In the Create panel, open the
Lights sub-panel.

3. In the Object Type rollout, click Omni.

4. In the Front viewport, click in the lower-
right corner to create the omni light
(Figure 11.19).

The objects in the scene are lit from
below and to the right. The plane does
not block the light because its surface
normals face away from the light 
(Figure 11.20).

5. In either the Top or Left viewport, move
the omni light slightly in back of the
scene so it is opposite the spotlight
(Figure 11.21). 

6. In the Intensity/Color/Attenuation roll-
out, reduce the Multiplier of the light to
around .5, or just enough to dimly illumi-
nate the dark sides of the objects.

7. Render the scene to see the result
(Figure 11.22).

8. Save the scene as Practice02.max.

✔ Tips

■ Click the plus sign “+” next to the Save
button in the Save File As dialog box to
increment your file by +01. 

■ If you add the two default lights in
Practice.max to the scene they will turn
into omni lights named DefaultKeyLight
and DefaultFillLight. Once added, you
can adjust them like other omni lights.
To do so, choose Views > Add Default
Lights to Scene. Note that the single
default light cannot be added to a scene.
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Figure 11.19 After
creating the omni
light in the Front
viewport.

Figure 11.20 The scene is now lit from below
right by the fill light.

Figure 11.21 After moving the omni light into
position.

Figure 11.22 The key light and fill light illuminate
the objects from the front left and back right.
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Free lights are aimed without using a target.
This makes them easier to transform and
animate. 

Free spotlights and directional lights are 
created with a single click. The light is auto-
matically aimed at the grid of the viewport
in which you clicked (a.k.a. the construction
grid).

To create a free directional light:

1. Open Practice02.max. 

2. In the Create panel, open the
Lights sub-panel.

3. In the Object Type rollout, click 
Free Direct.

4. In the Top viewport, click on top of an
object that you would like to highlight.

The free directional light appears in 
the viewport on top of the object
(Figure 11.23). 

5. In the Front or Left viewport, move the
directional light above the object. 

The light singles out the object with
additional illumination (Figure 11.24). 

6. In the Intensity/Color/Attenuation roll-
out, reduce the Multiplier so that it 
doesn’t bleach out the object. Try a 
setting of around .5. 

7. In the General Parameters rollout, check
On to enable shadow casting.

8. Open the Modify panel. Then select
the spotlight and reduce its intensity
multiplier to around 1.1.

9. Render the scene to see the result
(Figure 11.25).

10. Save the scene as Practice03.max.

✔ Tip

■ Decreasing a Multiplier setting to a 
negative value causes a light to remove
illumination from a scene. 

323

Lights
Creatin

g
 Lig

h
ts

Figure 11.23 Place the free directional light directly
over an object.

Figure 11.24 When you first set the directional
light, it may be too bright.

Figure 11.25 After adjusting the lights and turning
on cast shadows.
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A skylight acts as a dome of light to create
the illusion of outdoor lighting. No matter
where you place a skylight, it always illumi-
nates the scene from above. 

To create a skylight:

1. Open Practice.max. 

2. In the Create panel, open the
Lights sub-panel.

3. In the Object Type rollout, click Skylight.

4. Click in any viewport. 

The skylight appears in the viewport
(Figure 11.26). 

5. Choose Rendering > Advanced Lighting
from the menu bar.

6. In the Advanced Lighting dialog box,
open the drop-down menu and choose
Light Tracer. 

The Light Tracer rollout appears and
becomes active (Figure 11.27). 

7. To make the scene more realistic,
choose Render > Environment and
change the Environment Background
color to light gray. 

8. Click the ActiveShade viewport to 
activate it. 

9. From the Main toolbar, choose Quick
Render (Production).

The scene renders line by line. When it is
done, the skylight diffusely illuminates
the scene from above. Faint shadows
gather below each object (Figure 11.28).

10. Save as Practice04.max.
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Figure 11.26 Placing a skylight in the scene.

Figure 11.27 The Light Tracer controls skylights.

Figure 11.28 The skylight diffusely illuminates the
scene from above.
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A sunlight system is a combination of a 
free directional light and a compass rose
that sets the orientation of the system. 
Ray-traced shadows are on by default. 

To create a sunlight system:

1. Open Practice.max.

2. In the Create panel, open the
Systems sub-panel.

3. In the Object Type rollout, click Sunlight.

In sunlight system rollout, the time is set
to the time on your computer, and the
location is set to San Francisco, CA
(Figure 11.29).

4. In the Top viewport, click and drag to
create a compass rose of any size. 

5. Move the cursor up or down to set the
orbital distance of the sun. Then click to
create the light (Figure 11.30).

6. In the Sunlight System rollout, set the
time, date, and time zone for the light.
You can also set the latitude and longi-
tude, or pick a location by clicking Get
Location (Figure 11.31).

7. Open the Directional Parameters rollout
in the Modify panel, and uncheck Over-
shoot. Then increase the Hotspot until
the cone of illumination encompasses
the entire scene, so that shadows will
appear throughout.

8. Click the ActiveShade viewport. Then
click Quick Render (Production).

Sunlight floods the scene. The ray-
traced shadows are crisp and precise
(Figure 11.32). 

9. Save as Practice05.max.

✔ Tip

■ After creating a sunlight system, you
change its settings in the Motion panel. 
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Figure 11.29 The sunlight
system uses the time and
date on your computer to
position the light.

Figure 11.30 The compass sets the
direction; the light illuminates the scene.

Figure 11.31 Get a new location from the
list or click on a map of the world.

Figure 11.32 Sunlight renders with sharp-
edged ray traced shadows by default.
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A daylight system combines sunlight and
skylight into one integrated system. 

To create a daylight system:
1. Open Practice.max.

2. In the Create panel, open the
Systems sub-panel.

3. In the Object Type rollout, click Daylight.

The Daylight System rollout that appears
looks just like a Sunlight System rollout.

4. In the Top viewport, click and drag to
create a compass rose. Then move the
cursor up or down and click to set the
orbital distance of the daylight assembly
head (Figure 11.33).

5. In the Daylight System rollout, set the
time, date, and time zone for the light.
You can also set the latitude and longi-
tude, or pick a location by clicking 
Get Location.

This positions the sun in the sky.

6. At the bottom of the rollout, set the
brightness of the sky. Choose from Clear,
Partly Cloudy, or Cloudy. 

7. Choose Rendering > Advanced Lighting,
or press 9 on your keyboard. 

8. In the Advanced Lighting dialog box,
choose Light Tracer. 

9. Choose Rendering > Environment. In
the Environment dialog box, match the
Background color to the amount of
cloud cover that you set for the sky. 

10. In the Exposure Control rollout, choose
Automatic Exposure control from the
drop-down menu. Then Activate the
ActiveShade viewport, and click Render
Preview (Figure 11.34).

11. Adjust the exposure as needed. Then
click Quick Render (Production).

Sunlight and daylight illuminate the
scene (Figure 11.35). 

12. Save as Practice06.max. 
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Figure 11.33 The compass orients the daylight
assembly head to the location.

Figure 11.34 You adjust exposure in the Environment
dialog box.

Figure 11.35 The final scene is illuminated with both
sunlight and skylight.
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Casting Shadows
There are four types of shadows that you
can assign to a light: 

◆ Shadow maps are bitmaps that are 
projected from a light. They are created
by the scanline renderer during a pre-
rendering pass of the scene and applied 
during rendering. Shadow maps give
shadows a soft edge, as if they are 
being diffused by the atmosphere
(Figure 11.36). 

Shadow maps are the default shadow
type for most lights. 

◆ Area shadows simulate shadows that
are cast from an illuminated area or 
volume. They use anti-aliasing to 
produce soft, atmospheric shadows
(Figure 11.37). 

◆ Ray-traced shadows are more precise
and sharp-edged than shadow-map 
shadows. They are calculated by tracing a
ray from source to object. Use ray-traced
shadows whenever you need to precisely
locate shadows, such as in shadow 
studies for architectural siting 
(Figure 11.38).

Ray-traced shadows are the default type
for sunlight systems. 

◆ Advanced ray-traced shadows are a
variation of ray-traced shadows that also
use anti-aliasing to produce soft edges
(Figure 11.39).
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Figure 11.36 Shadow-map shadows have soft edges.

Figure 11.37 Area shadows produce soft, atmospheric
shadows.

Figure 11.38 Ray-traced shadows have hard edges.

Figure 11.39 Advanced ray-traced shadows use anti-
aliasing to produce soft edges.
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Once you select a shadow type, you can
adjust its color, density, and position, plus
other qualities specific to that type. The
adjustments that you make to a shadow
determine the speed at which it will render. 

To change shadow type:

1. Open Practice02.max.

2. Render the scene to get an accurate
idea of what the shadows currently look
like (Figure 11.40).

3. Select a light that casts shadows.

4. Open the Modify panel.

5. In the General Parameters rollout, choose
a shadow type from the drop-down list
(Figure 11.41).

6. Render the scene to see the result
(Figure 11.42). 

✔ Tip

■ Ray-traced shadows render more slowly
when you use them with omni lights. If
possible, use ray-traced shadows with
spotlights or directional lights instead. 
If you still need the effect of an omni or
directional light, check Overshoot so the
shadows will only be calculated within
the cone.
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Figure 11.40 The practice scene has soft shadow
mapped shadows.

Figure 11.41
Changing the
shadow type to ray-
traced shadows.

Figure 11.42 The ray-traced shadows are more crisp
and precise.
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Shadow maps sometimes appear blurry,
faint, or detached from the objects that cast
them. Shadow-map parameters help you fix
these problems (Figure 11.43):

◆ Bias—Offsets shadows from the object
that casts them. Lowering the Bias value
moves shadows closer to the object. 

◆ Size—Controls the resolution of a 
shadow by setting the size of the bitmap
that generates the shadow. Increasing
this parameter sharpens shadow edges
and increases rendering time. 

◆ Sample Range—Controls the sharpness
of shadows by averaging different sized
areas of the shadow map. If a shadow
smudges, streaks, or creates moiré pat-
terns, the Sample Range setting is proba-
bly too high. A Sample Range setting
that is too low creates jagged shadows. 

◆ Absolute Map Bias—Determines how
the map bias is computed in relation to
the rest of the scene. Use this option to
end flickering shadows in an animation.

◆ 2-Sided Shadows—Causes surfaces to
cast shadows as if they were double sided.

To get the most accurate feedback, render
the scene after you change each parameter. 

To adjust a shadow map: 
1. Select a light that has a problematic

shadow map, such as the spotlight in
Practice02.max.

2. Open the Modify panel.

3. Open the Shadow Map Params rollout
(Figure 11.44).

4. Increase the Size and the Sample Range to
improve the resolution of the shadow. Then
decrease the Bias until the shadows touch
the objects that cast them. To make the gap
between the teapot and its lid disappear,
check 2 Sided Shadows (Figure 11.45).

5. Save the scene.
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Figure 11.43 Before and after adjusting a shadow map.

Figure 11.44 The Shadow Map
Params rollout provides the
means to correct shadow maps.

Figure 11.45 Increasing the map size and sample
range focuses the shadow. Adjusting the map bias
brings the shadow bank into alignment.
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Ray-Traced shadows produce hard-edged
shadows that rarely need correcting. Like
shadow map shadows, they allow you to
adjust the shadow bias and render 2-sided
shadows. In addition, the Max Quadtree
Depth setting controls the rendering speed
of ray-traced shadows by setting the 
maximum size of the data structure that
generates them. 

Advanced Ray-Traced shadows allow you 
to add anti-aliased edges and control their
smoothness. You can also add noise to the
shadows to offset shadow artifacts. 

For more information on shadow parame-
ters for each of the shadow types, open 
the 3ds max 5 User Reference and go to
Contents > Lights and Cameras > Lights >
Rollouts for Specific Shadow Types.

To speed up rendering of ray-traced
shadows: 

1. Open Practice05.max. Then select Sun01
(Figure 11.46).

2. Open the Modify panel.

3. Open the Ray Traced Shadow Params
menu.

4. Increase the Max Quadtree depth
(Figure 11.47).

5. Render the scene.

The scene renders faster. 
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Figure 11.46 This sunlit scene has ray-traced shadows
that are slow to render.

Figure 11.47 Increase the Max
Quadtree Depth if you have plenty
of RAM.
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To anti-alias ray-traced shadows:

1. In the General Parameters rollout,
convert the shadows of the Sun01 object
to advanced ray-traced shadows.

2. Open the Adv. Ray Traced rollout
(Figure 11.48).

3. Increase the Shadow Integrity to 5 and
the Shadow Quality to 10. Then increase
the Shadow Spread to 4. 

4. Render the scene (Figure 11.49). 

5. Continue to play with the parameters
until you get the effect that you like. Be
sure to try increasing the Jitter Amount
to see what it looks like when you add
noise to the shadow. 
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Figure 11.48 The Adv.
Ray Traced Params
rollout allows you to
set options for anti-
aliasing and adding
noise to ray-traced
shadows.

Figure 11.49 The anti-aliased shadows have
softer edges.
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You can set shadow color for all types of
shadows independently of the color of the
light. Use this feature to simulate reflected
color from nearby objects or from secondary
light sources such as the sky. 

To set shadow color:

1. Select a light that casts shadows 
(Figure 11.50).

2. Open the Modify panel.

3. Open the Shadow Parameters rollout.

4. Click the Color swatch (Figure 11.51).

5. Choose a color in the Color Selector:
Shadow Color dialog box (Figure 11.52). 

6. Render the scene.

The shadow changes color (Figure 11.53).
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Figure 11.50 The object casts a black shadow.

Figure 11.52 Choosing a light-blue color.

Figure 11.53 The object now casts a light-blue shadow.

Figure 11.51 Click the
color swatch.
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The Density parameter sets the value, or
darkness, of the shadows without affecting
their hue and saturation. Use this feature 
to fill in shadows or to make them more
transparent. 

To set shadow density:

1. Select a light that casts shadows 
(Figure 11.54). 

2. Open the Modify panel.

3. Open the Shadow Parameters rollout.

4. Set the Density value of the shadow
(Figure 11.55).

5. Render the scene.

The shadow becomes darker or lighter
(Figure 11.56).

✔ Tips

■ To mix the color of the light with the
shadow color, check Light Affects
Shadow Color in the Shadow Parameters
rollout. 

■ To project a map into a shadow, check
Map, click the None button, and choose
a map.
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Figure 11.54 The object casts a shadow of
Density = 1.0.

Figure 11.55 Decreasing the
density of the shadow.

Figure 11.56 The shadow lightens.
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Shadow casting is an arrangement between
two parties: Both the light and the object
have to be set to cast shadows before 
shadows will be rendered. If you turn off 
the shadow-casting property of an object, 
it will not cast shadows for any light.

To turn off shadow casting for 
an object:

1. Open a scene that is illuminated by a
light (Figure 11.57).

2. Select an object that is casting a shadow.

3. Right-click on the object, and choose
Properties from the Transform quad
menu.

4. In the Object Properties dialog box,
uncheck Cast Shadows (Figure 11.58).

5. Click OK.

6. Render the scene to see the results
(Figure 11.59).

✔ Tip

■ To prevent any shadows from falling
across an object, uncheck Receive
Shadows in its Object Properties dialog
box (Figure 11.60).
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Figure 11.57 In this scene, the teapot 
overshadows the tube.

Figure 11.59 Turning off Cast Shadows for 
the teapot.

Figure 11.60 The tube stands within the teapot’s
shadow but is not shaded by it.

Figure 11.58 
After turning off the
teapot’s shadow, 
the tube stands out.
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Controlling Illumination
Controlling illumination is essential to 
creating realistic scenes. The following
parameters fine-tune colors and gradations
of light, and determine the surfaces that
light will affect (Figure 11.61):

◆ On—Enables illumination. 

◆ Type—Sets the light type.

◆ Targeted—Enables a target. 

◆ Cast Shadows—Enables shadow 
casting. 

◆ ShadowType—Sets the shadow type.

◆ Include/Exclude—Determines which
objects are illuminated by the light. 

◆ Multiplier—Controls the intensity, or
brightness, of a light.

◆ Color—Sets the hue (chroma), satura-
tion (purity), and value (intensity) of 
a light.

◆ Decay—Diminishes the intensity of a
light over its entire attenuation range.

◆ Attenuation—Fades the light at either
end of its range.

◆ Hot Spot and Falloff—Sets the inner
and outer boundaries of the cone of 
illumination. 

◆ Contrast—Sets the contrast 
between ambient and diffuse areas 
of illumination.

◆ Soften Diff. Edge—Softens the edge
between ambient and diffuse areas.

◆ Diffuse—Adds the light to diffuse 
(middle value) areas of illumination. 

◆ Specular—Adds light to specular (high
value) areas of illumination.

◆ Ambient Only—Adds light to the mini-
mum level of scene illumination. 

◆ Projector Map—Projects an image or
animation into a scene.
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Figure 11.61 The parameters of a
spotlight are the same as those of
a directional light, and have much
in common with omni lights.
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By default, lights illuminate all objects 
within range. Turning off a light ends their
illumination. Note that hiding a light does
not turn it off.

To turn off a light:

1. Open Practice03.max (Figure 11.62).

2. Select a light.

3. Open the Modify panel.

4. Uncheck the On box in the General
Parameters rollout (Figure 11.63).

The light is turned off (Figure 11.64).

5. To turn the light back on, check the 
On box. 
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Figure 11.62 The practice scene before turning off the
spotlight.

Figure 11.63 Uncheck the On box.

Figure 11.64 After turning off the spotlight, the scene is
just illuminated by the direct light and the omni light.
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You can convert a light from one type to
another in the Modify panel. When a light
changes type, the illumination from the new
light type replaces the illumination from the
old type. 

To change a light type:

1. Open Practice03.max.

2. Select a light.

3. Open the Modify panel.

4. In the General Parameters rollout, choose
a light type from the Light Type drop-
down list (Figure 11.65).

The new light type replaces the selected
light, using the same basic settings. 

The name of the light remains unchanged.
If the name of the light is Omni01 and you
have just changed it to a target spotlight,
this is probably a good time to rename it. 

5. Activate the ActiveShade viewport, and
render the scene.

The new light type replaces the old and
illuminates the scene (Figure 11.66).

✔ Tips

■ When you convert an omni light to any
other type of light, it points toward the
grid of the viewport it was created in.

■ The Targeted check box toggles a target
on or off. 

Figure 11.65 Changing the spotlight to
a directional light.

Figure 11.66 The spotlight has been changed to a
direct light, which is narrower at the far end of its cone.
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The Exclude command turns off the illumi-
nation of objects that are within range of a
light. It can also turn off shadow casting. 

To exclude objects from a light:

1. Open Practice02.max.

2. Select the spotlight.

3. Open the Modify panel.

4. Click Exclude in the General Parameters
rollout (Figure 11.67).

The Exclude/Include dialog box appears.

5. Make sure Exclude and Both are selected
in the upper-right corner.

6. Select the names of the objects or group
of objects you do not want to be illumi-
nated or to cast shadows.

7. Click the >> button.

The names of the objects are moved 
to the Exclude list on the right 
(Figure 11.68).

8. Click OK.

9. Render the scene. 

The excluded objects neither receive 
illumination nor cast shadows, giving
them an air of mystery (Figure 11.69). 

✔ Tips

■ To remove objects from the exclude list,
and end the exclusion of objects, click
the Clear button. 

■ Using the Include button, you can selec-
tively choose just those objects you want
to include in a light. All other objects will
be excluded automatically. 
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Figure 11.67 Click the Exclude button.

Figure 11.68 Turning off both illumination and
shadow casting for the cylinders, hedra, and teapot.

Figure 11.69 Without shadows or major illumination,
the excluded objects appear to float in the scene.
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Color settings assign hue, value, and 
saturation to a light. The value of a color
also affects its intensity. Brighter colors 
create brighter lights. Darker colors create
dimmer lights.

To set color:

1. Open Practice02.max.

2. Select the spotlight.

3. In the Intensity/Color/Attenuation roll-
out, click the color swatch just to the
right of the Multiplier (Figure 11.70).

4. Choose a color from the Color Selector
dialog box. There are two basic methods:

The most intuitive way to do this is to
click in the Hue palette on the left and
drag the Whiteness slider next to it
(Figure 11.71).

When precision is important, you can set
numeric RGB or HSV values using the
color sliders, input fields, or spinners on
the right (Figure 11.72). 

As you change the color of the light, the
lighting updates in the shaded viewports.

5. When you are satisfied with the result,
close the Color Selector dialog box. 

6. Render the scene to verify the results
(Figure 11.73).

✔ Tip

■ Light and color can be animated 
over time.

Figure 11.70 Click the
color swatch.

Figure 11.71 Picking a color using the
palette and whiteness slider.

Figure 11.72 Picking the same color
numerically.

Figure 11.73 Blue light gives the scene a more
somber cast.
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Global lighting commands shift the base
intensity and color of all the lights in a
scene, including the default lights. 

Initially, the base intensity is set to 1.0 and
the base color is set to white. Ambient light,
which sets the minimum level of scene illu-
mination, is set to black (no light). Changing
these settings will affect the overall amount
of color and illumination of the scene. 

Because ambient light brightens darker 
values, increasing it reduces contrast across
surfaces. Use this setting sparingly, so it
does not wash out your scene.

To set global lighting:

1. Open Practice03.max (Figure 11.74).

2. Choose Rendering > Environment to
open the Environment dialog box.

3. In the Global Lighting group, set the base
intensity of the lights by adjusting the
Level (Figure 11.75).

The scene brightens or dims 
(Figure 11.76).

4. Reset the Level to 1.0, then click the Tint
color swatch.

5. In the Color Selector: Global Tint dialog
box, choose a hue and whiteness value. 

The color and intensity of the illumina-
tion updates.

6. Click the Ambient color swatch. 

The Color Selector changes to the Color
Selector: Ambient Light dialog box.

7. Drag the Whiteness slider to set the 
minimum level of illumination. Then
select a hue. 

Gradations of value become lighter
throughout the scene, and become tinted
by the hue that you selected. 

8. Render the scene to see the results
(Figure 11.77).

Figure 11.74 Before affecting the global lighting of
the scene.

Figure 11.75 Reducing the global illumination.

Figure 11.76 All the lights are dimmed.

Figure 11.77 Increasing the value of the ambient
color reduces contrast in the scene.
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A light cone is actually made of two concen-
tric cones: the inner core of illumination, or
hotspot, and the outer edge of illumination,
or falloff. Between the hotspot and falloff
cones, the intensity of the light gradually
decreases to zero. 

To set the hotspot and falloff:
1. Open Practice03.max
2. Select the spotlight.
3. Open the Modify panel.
4. In the Spotlight Parameters rollout,

decrease the Falloff value. Then 
decrease the Hotspot value even more 
(Figure 11.78).
The blue hotspot cone becomes 
narrower (Figure 11.79).
In the ActiveShade viewport, the edge 
of the pool of light becomes softer
(Figure 11.80). 

5. Select the directional light.
6. In the Directional Parameters rollout,

decrease the Falloff amount so that both
the hotspot and falloff cones become
narrower.

7. Render the ActiveShade viewport.
The pool of light from the directional
light becomes smaller, but its edges
remain sharp (Figure 11.81).

✔ Tips
■ Check Show Cone to display the cone

even when the light is not selected. 

■ Checking Overshoot causes the light to
ignore the boundaries of the hotspot and
falloff cones and spread throughout the
scene. Shadows, however, will be drawn
within the cone of illumination only. 

■ Click Rectangle to make the pool of 
light rectangular or square. The Aspect
parameter sets the aspect ratio of the
length and width of the rectangle. The
Bitmap Fit button will match the aspect
ratio to an external bitmap, in case you
want to project the map, as shown in 
the next exercise. 

Figure 11.78 Adjust
the hotspot and falloff
in the spotlight
parameters rollout.

Figure 11.79 The hotspot and
falloff cones move apart.

Figure 11.80 The pool of light gains a softer edge.

Figure 11.81 The cone of the directional light
narrows.
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Projecting maps into a scene creates the 
illusion that there is more going on than
meets the eye. 

To project a map:

1. Open Practice02.max.

2. Select the spotlight. 

3. Open the Modify panel.

4. In the Advanced Effects rollout, click 
the Projector Map button labeled None
(Figure 11.82).

The Material/Map Browser window
appears.

5. Double-click Bitmap (Figure 11.83). 

6. Choose a bitmap image using the Select
Bitmap Image File dialog box. For this
example, I chose the SCATR4.gif in the
3dsmax5/Maps/Lights folder. 

When you click Open, the bitmap image
is projected by the spotlight onto the
scene.

7. Increase the light multiplier to compen-
sate for the reduced intensity of the
bitmap. 

8. Render the scene (Figure 11.84).

✔ Tips

■ A black-and-white map that is designed
to be used with a spotlight is called a
gobo map. 

■ Try some of the other maps in the
Material/Map Browser such as Brick,
Cellular, Checker, Dent, Gradient 
Ramp, Perlin Marble, and Smoke 
(Figure 11.85).

Figure 11.82 Click the
Projector Map button.

Figure 11.84 The SCATR4 map projects spots of light
and shadow.

Figure 11.85 Projecting a checker map that has been
tiled in the Material Editor.

Figure 11.83 
Click Bitmap in 
the Material/Map
Browser.

0879 ch11  6/23/03  2:59 PM  Page 342



343

Lights
Co

n
tro

llin
g

 Illu
m

in
atio

n

Attenuation fades in a light near its 
source and fades out a light at the far end 
of its range. 

To set attenuation:

1. Open Practice02.max.

2. Select the spotlight.

3. Open the Modify panel and the
Intensity/Color Attenuation rollout.

4. In the Far Attenuation group, check Use
and Show (Figure 11.86).

The far attenuation ranges appear. In 
the ActiveShade view, the light from the
spotlight will disappear if the objects are
out of the light’s current attenuation
range. 

5. Drag the Far Attenuation spinners so
that the Start and End ranges just
enclose the scene objects (Figure 11.87).

6. Render the scene to see the final result
(Figure 11.88).

✔ Tips

■ Because light can continue shining 
forever, it is a good idea to use far attenu-
ation so that the program won’t waste
time making unnecessary calculations. 

■ The Decay parameter increases the rate
at which a beam of light diminishes as it
moves away from its source.

Figure 11.86 Check
Use and Show for 
Far Attenuation.

Figure 11.87 Setting the Far Attenuation range
indicators.

Figure 11.88 The light falls off across the scene more
dramatically.
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Volume lighting is an atmospheric effect
that is based on the real-world interaction
between light and particulate matter such as
fog, haze, dust, and smoke. It gives you the
hazy glow of streetlights on a misty evening,
the sweep of a lighthouse beacon on a foggy
morning, or the rays of sunlight streaming
through a window.

Volumetric lighting works with all types of
light sources, although it is most commonly
used with spotlights. Because volume light-
ing is a true 3D effect, you can render it 
only from viewports that use perspective
projection.

To create a volume light:

1. Select a light that illuminates a scene.

2. Open the Modify panel.

3. Open the Atmospheres & Effects rollout.
(Note: This rollout does not appear in the
Create panel.) 

4. Click the Add button (Figure 11.89).

5. Choose Volume Light from the Add
Atmosphere or Effect dialog box
(Figure 11.90). Then click OK.

6. Render the scene from a Perspective,
Camera, or Light viewport.

The light is rendered volumetrically
(Figure 11.91). 

✔ Tips

■ Decreasing the size of the hotspot can
make a Volume Light easier to control.

■ By animating attenuation, you can 
make a Volume Light “touch down” and
“beam up.” 

■ Combining a projector map with a
Volume Light creates interesting effects
(Figure 11.92).

Figure 11.89 
Click Add in the
Atmospheres &
Effects rollout.

Figure 11.90 Add
Volume Light to 
the spotlight.

Figure 11.91 The Volume Light renders in three
dimensions.

Figure 11.92 When added to a Volume Light, a Cellular
map projects in three dimensions.
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Navigating Lights
When you activate a light view, the viewport
window controls change to a new set of 
navigation buttons called the light viewport
controls (Figure 11.93). By navigating lights
with the light viewport controls, you can
fine-tune their placement and animate them
over time. 

The names of light viewport controls are
based on traditional terms for making
movies. For a complete description of the
light viewport controls, see Table 11.1.

Figure 11.93 The Light
window controls navigate
Light viewports.

I c o n N a m e D e s c r i p t i o n

Dolly Light Moves light along its local Z axis or line of sight. 

Dolly Light + Target Moves light and target along light’s Z axis.

Dolly Target Moves target along light’s Z axis.

Light Hotspot Changes the size of the hotspot.

Light Falloff Changes the size of the falloff.

Roll Light Rotates light around its Z axis.

Zoom Extents All Centers objects in all non-fixed viewports.

Zoom Extents All Selected Centers selected objects in all non-fixed viewports.

Truck Light Moves light and target parallel to the view plane. 

Orbit Light Rotates light around its target. 

Pan Light Rotates light. Target rotates around light. 

Min/Max Toggle Toggles between viewport layout and full display.

Table 11.1

Light Viewport Controls

Note: Free lights use virtual targets for the Dolly, Truck, Pan, and Orbit commands.
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You can look at a scene from the point of
view of a spotlight or a directional light. 

To change a view to a light view:

1. Open a scene that has a spotlight or
directional light in it. 

2. Activate the viewport you want to
change.

3. Type $ (Shift + 4).

The Select Light dialog box appears
(Figure 11.94).

4. Select a light, and click OK.

The view in the viewport changes to the
Light view (Figure 11.95). 

Figure 11.94 The Select
Light dialog box prompts
you to choose a light.

Figure 11.95 The Light viewport shows how the scene
looks from the standpoint of the light.
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To dolly a light:

1. Change a view to a Light view 
(Figure 11.96).

2. Click the Dolly Light button in the
light viewport controls. 

3. Drag the dolly cursor up or down in the
Light viewport.

The light moves in or out along its local
Z axis, or “line of shine” (Figure 11.97).

The pool of illumination shrinks or
expands (Figure 11.98).

✔ Tips

■ To dolly a target, choose Dolly Target
from the Dolly Light flyout. 

■ To dolly a light and its target together,
choose Dolly Light + Target from the
same flyout. 

Figure 11.96 Open the Spotlight viewport.

Figure 11.97 The scene enlarges in the viewport after
you dolly the light closer to its target.

Figure 11.98 The pool of illumination shrinks as
a result.
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The Truck command moves a light and its
target across a scene parallel to the plane of
the Light viewport.

To truck a light:

1. Open a scene with a light in it 
(Figure 11.99).

2. Change a view to a Light view 
(Figure 11.100).

3. Click the Truck Light button. 

4. Drag the panning hand across the 
Light viewport.

The Light viewport moves across the
scene (Figure 11.101).

The cone of illumination moves as well
(Figure 11.102).

Figure 11.99 The scene before you truck
the light.

Figure 11.100 The view from the light shows
the pool of illumination from above.

Figure 11.101 Use the panning hand to truck
the light.

Figure 11.102 Compare the result to the
Light viewport.

0879 ch11  6/23/03  3:00 PM  Page 348



349

Lights
N

avig
atin

g
 Lig

h
ts

Roll rotates a light along its line of sight.
This affects the scene only if the light casts
a rectangular cone or uses a projector map.

To roll a light:

1. Open a scene that is lit by a rectangular
cone of illumination (Figure 11.103).

2. Change a view to a Light view 
(Figure 11.104).

3. Click Roll Light.

4. Drag the roll cursor across the Light
viewport.

The light rotates around its depth axis
(Figure 11.105).

The pool of illumination, and any maps
that are being projected, roll with the
light (Figure 11.106).

Figure 11.103 Using a rectangular cone of
illumination, the light projects a Brick map
onto the scene.

Figure 11.104 Before rolling the light.

Figure 11.105 After rolling the light about 50°.

Figure 11.106 The map rolls with the projector.
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Orbit Light moves a spot or directional light
around its target. If the light is a free light, it
uses a virtual target located at the end of the
light cone.

To orbit a light:

1. Open a scene (Figure 11.107).

2. Change a viewport to a Light view
(Figure 11.108).

3. Click the Orbit Light button in the
Light viewport controls.

4. Drag the cursor in the Light viewport.

The light rotates around its target
(Figure 11.109).

The light orbits around the scene
(Figure 11.110).

✔ Tip

■ To align a light to a surface normal,
select the light and choose Place
Highlight from the Align flyout. Then
click the object. The light aligns to the
normal and creates a highlight on the
surface. It remains at the same distance
from the object as it was before. For
more information on controlling 
highlights, see Chapter 13, “Creating
Materials.”

Figure 11.107 This scene is mainly lit from
above and to the left.

Figure 11.108 The view from the spotlight
that provides most of the illumination.

Figure 11.109 Orbiting the light around its
target.

Figure 11.110 The scene is now illuminated
from above and to the right.
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Pan rotates a target around a light. If the
light is a free light, it uses a virtual target
located at the end of the light cone.

To pan a light:

1. Open a scene that is lit by a spotlight or
a directional light (Figure 11.111).

2. Change a view to a Light view 
(Figure 11.112).

3. Click the Pan Light button in the
Light viewport controls, located on the
Orbit Light flyout.

4. Drag the cursor across the Light 
viewport.

The Light view pans across the scene
(Figure 11.113).

The light sweeps across the scene
(Figure 11.114).

Figure 11.111 The light initially falls on the
left front corner of the scene.

Figure 11.112 The view from the Light view-
port shows the area of illumination.

Figure 11.113 Panning the light across
the scene.

Figure 11.114 The light sweeps across
the scene.
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Animating Lights
Lights are animated by keyframing or link-
ing, or by assigning animation controllers 
to them. 

Any numerical parameter of a light can 
be keyframed, including intensity, color, 
contrast, hotspot, falloff, attenuation, and
shadow density. You can also keyframe the
position and orientation of a light using 
the Move and Rotate transforms and the
Light window controls. However, parameters
that use checkboxes cannot be keyframed. 

Linking a light to a moving object ensures
that the light will illuminate the object 
or objects nearby—think running lights or
headlights on a car. If the light is linked to 
a camera, the light will shine wherever the
camera is pointed.
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The Look At constraint turns a light into a
searchlight that always points at a target
object. Moving the target over time is an
easy way to animate the light. (Use a non-
rendering helper object such as a dummy or
a point if you do not want the target to be
seen.) 3ds max automatically assigns the
Look At constraint to spotlights and direc-
tional lights, so all you need to do is tell the
light where to look.

To make lights follow an object:

1. Open Practice03.max, and close the
ActiveShade view. (Note: The scene may
shift a little when you close the view.)

2. Link the omni light to the object above it
(Figure 11.115).

3. Turn off the spotlight. Then increase the
Multiplier of the directional light to 1.5
(Figure 11.116).

4. In the Modify panel, convert the direc-
tional light to a Target Direct type. 

5. Open the Motion panel.

6. In the Look At Parameters rollout, click
the Pick Target button (Figure 11.117).
Then click the highlighted object. 

7. Move the object.

The lights follow the object 
(Figure 11.118).

Figure 11.115 Linking the omni light to the hedra.

Figure 11.116 The hedra is lit from above and below.

Figure 11.117 Pick the hedra
to be the Look At target.

Figure 11.118 When you move the hedra, the omni
light and the target light follow it.
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By animating the intensity multiplier, you
can make lights dim and brighten over time. 

To animate light intensity:

1. Open Practice03.max. 

2. Close the ActiveShade view. Then pan
the Perspective viewport so that the
hedra is in the center of the composition.

3. Choose Tools > Light Lister. 

4. In the Light Lister dialog box, turn off
the spotlight and set the omni Multiplier
to 0 (Figure 11.119).

The scene dims (Figure 11.120).

5. Turn on the Auto Key button, and drag
the time slider to frame 50.

6. In the Light Lister, set the directional
light multiplier to 1.5. Then set the 
omni light multiplier to.5 
(Figure 11.121).

7. Drag the time slider to frame 100.

8. Set the intensity of both the directional
light and the omni light to 0.

9. Play back the animation.

The lights brighten and dim to darkness. 

✔ Tips

■ To animate a light turning on and off,
change the tangent type of the Multiplier
keys to Step, or assign an On/Off 
controller to the Multiplier track.

■ By cloning the directional light and
adding volume and a projector map, you
can create a transporter that beams up
your objects (Figure 11.122).

Figure 11.119 Adjust the light settings in
the Light Lister utility.

Figure 11.120 Start with a dim illumination.

Figure 11.121 As the overhead light brightens to
full intensity, the fill light brightens with it.

Figure 11.122 Beam me up, Scotty!
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